SINAMICS S120
Getting Started with the STARTER Commissioning Tool
Getting Started with the STARTER Commissioning Tool

Valid for

<table>
<thead>
<tr>
<th>Control</th>
<th>Firmware release</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINAMICS S120</td>
<td>2.1</td>
</tr>
<tr>
<td>SINAMICS S120</td>
<td>2.2</td>
</tr>
<tr>
<td>SINAMICS S120</td>
<td>2.3</td>
</tr>
<tr>
<td>SINAMICS S120</td>
<td>2.4</td>
</tr>
</tbody>
</table>

03/2006 Edition
SINAMICS® Documentation

Printing history

Brief details of this edition and previous editions are listed below.

Letters in the "Remarks" column indicate the status of the editions that have been published up until now.

Status code in the "Remarks" column:

A New documentation
B Unrevised reprint with new Order No.
C Revised edition with new status

If the technical information on the particular page has changed since the previous edition, then this is indicated by a new edition coding in the header line of the particular page.

<table>
<thead>
<tr>
<th>Edition</th>
<th>Order No.</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prelim. 03.03</td>
<td>6SL3 097–0AG00–0BP0</td>
<td>A</td>
</tr>
<tr>
<td>04.04</td>
<td>6SL3 097–2AG00–0BP0</td>
<td>C</td>
</tr>
<tr>
<td>12.04</td>
<td>6SL3 097–2AG00–0BP1</td>
<td>C</td>
</tr>
<tr>
<td>06.05</td>
<td>6SL3–097–2AG00–0BP2</td>
<td>C</td>
</tr>
<tr>
<td>03.06</td>
<td>6SL3–097–2AG00–0BP3</td>
<td>C</td>
</tr>
</tbody>
</table>

Trademarks
SIMATIC®, SIMATIC HMI®, SIMATIC NET®, SIMOTION®, SINAMICS®, SIROTEC®, SINUMERIK®, and SIMODRIVE® are registered trademarks of Siemens AG. The designations in this documentation may be trademarks whose use by third-parties for their own purposes may infringe the rights of the owner.
# Preface

## SINAMICS Documentation

The SINAMICS documentation is structured in 2 levels:

- General documentation/catalogs
- Manufacturer/Service Documentation

An overview of publications, which is updated on a monthly basis, and also provides information about the language versions available, can be found on the Internet at:


Select the menu items "Support" ' "Technical Documentation" ' "Overview of Publications".

The Internet version of DOConCD (DOConWEB) is available at:


Information about training courses and FAQs (Frequently Asked Questions) can be found on the Internet at:

[http://www.siemens.com/motioncontrol](http://www.siemens.com/motioncontrol) under the menu option "Support"

<table>
<thead>
<tr>
<th>Usage phase</th>
<th>Document/tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exploratory</td>
<td>SINAMICS S Sales Documentation</td>
</tr>
<tr>
<td>Planning/configuration</td>
<td>SIZER configuration tool</td>
</tr>
<tr>
<td>Decision/ordering</td>
<td>SINAMICS S Catalogs</td>
</tr>
<tr>
<td>Installation/assembly</td>
<td>• SINAMICS S120 Equipment Manual for Control Units and Supplementary System Components</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S120 Equipment Manual Power Modules Booksizes</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S120 Equipment Manual Power Modules Chassis</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S150 Operating Manual</td>
</tr>
</tbody>
</table>
Table 1-1 Usage phases and the available documents/tools

<table>
<thead>
<tr>
<th>Usage phase</th>
<th>Document/tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commissioning</td>
<td>• STARTER Parameterization and Commissioning Tool</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S120 Getting Started</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S120 Commissioning Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S120 CANopen Commissioning Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S List Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S150 Operating Manual</td>
</tr>
<tr>
<td>Usage/operation</td>
<td>• SINAMICS S120 Commissioning Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S List Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S150 Operating Manual</td>
</tr>
<tr>
<td>Maintenance/servicing</td>
<td>• SINAMICS S120 Commissioning Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S List Manual</td>
</tr>
<tr>
<td></td>
<td>• SINAMICS S150 Operating Manual</td>
</tr>
</tbody>
</table>

Target group

This Manual is intended for machine manufacturers, commissioning engineers, and service personnel who use the SINAMICS S drive system.

Benefits

Note

"SINAMICS S120 Getting Started with the STARTER Commissioning Tool" provides an example illustrating how to commission a SINAMICS S120 drive line-up.

Detailed instructions on commissioning the entire SINAMICS S120 drive line-up are available in the SINAMICS S120 Commissioning Manual.

The individual chapters provide information on the following:

• Drive concept
• Prerequisites
• Creating the drive project OFFLINE
• Using the STARTER control panel (motor rotates)
• Creating the drive project ONLINE
Standard scope

The function of the standard scope is described in this documentation. Supplements or changes made by the machine manufacturer are documented by the machine manufacturer.

Other functions not described in this documentation might be able to run in the drive system. However, this does not represent an obligation to supply such functions or when servicing.

Further, for the sake of simplicity, this documentation does not contain all detailed information about all types of the product and cannot cover every conceivable case of installation, operation, or maintenance.
Technical Support

If you have any questions, please get in touch with our Hotline

Europe and Africa time zone

A&D Technical Support
Tel.: +49 (0) 180 / 5050 – 222
Fax: +49 (0) 180 / 5050 – 223

Internet: http://www.siemens.com/automation/support-request
E–mail: mailto:adsupport@siemens.com

Asia and Australia time zone

A&D Technical Support
Tel.: +86 1064 719 990
Fax: +86 1064 747 474

Internet: http://www.siemens.com/automation/support-request
E–mail: mailto:adsupport@siemens.com

America time zone

A&D Technical Support
Tel.: +1 423 262 2522
Fax: +1 423 262 2289

Internet: http://www.siemens.com/automation/support-request
E–mail: mailto:adsupport@siemens.com
Questions about the manual

If you have any questions (suggestions, corrections) regarding this documentation, please fax or e-mail us at:

Fax: +49 (0) 9131 / 98 – 63315
E-mail: mailto:motioncontrol.docu@siemens.com

Fax form: Refer to the reply form at the end of this manual

Internet address for SINAMICS

http://www.siemens.com/sinamics

EC Declaration of Conformity

The EC Declaration of Conformity for the EMC Directive can be found/obtained

- on the Internet:
  http://www.ad.siemens.de/csinfo
  under the Product/Order No. 15257461
- at the relevant branch office of the A&D MC Business Division of Siemens AG
Safety Instructions

This Manual contains information which you should carefully observe to ensure your own personal safety and the prevention of material damage. Notices which are relevant to your own personal safety are highlighted by a safety alert symbol; notices which are relevant only to equipment and property damage have no safety alert symbol. The warnings appear in decreasing order of risk as given below.

---

**Danger**

indicates that death or serious injury **will** result if proper precautions are not taken.

---

**Warning**

indicates that death or serious injury **may** result if proper precautions are not taken.

---

**Caution**

with a warning triangle indicates that minor personal injury can result if proper precautions are not taken.

---

**Caution**

without a warning triangle this indicates that property damage may occur if proper precautions are not taken.

---

**Notice**

indicates that an unintended result or situation can occur if the corresponding information is not taken into account.
Note
This symbol always appears in this documentation where further, explanatory information is provided.

If several hazards of different degrees occur, the hazard with the highest degree must always be given priority. If a warning note with a warning triangle warns of personal injury, the same warning note can also contain a warning of material damage.

Qualified personnel
The associated device/system may only be set up and operated using this documentation. A device/system must only be commissioned and operated by qualified personnel. Qualified persons are defined as persons who are authorized to commission, ground, and tag equipment, systems, and circuits in accordance with established safety standards.
ESDS information

Caution

ElectroStatic Discharge Sensitive devices (ESDS) are individual components, integrated circuits, or modules that can be damaged by electrostatic fields or discharges.

Instructions for handling ESDS devices:

- When handling electronic components, you must ensure that the person carrying out the work, the work place, and packaging are properly grounded.
- Personnel in ESDS areas with conductive flooring may only handle electronic components if:
  - They are grounded with an ESDS wrist band
  - They are wearing ESDS shoes or ESDS shoe grounding straps
- Electronic boards should only be touched if absolutely necessary. They must only be handled on the front panel or, in the case of printed circuit boards, at the edge.
- Electronic boards must not come into contact with plastics or items of clothing containing synthetic fibers.
- Boards must only be placed on conductive surfaces (work surfaces with ESDS surface, conductive ESDS foam, ESDS packing bag, ESDS transport container).
- Electronic modules must be kept at a distance from data display equipment, monitors, and televisions (minimum distance from screen: >10 cm).
- Measurements must only be taken on boards when:
  - The measuring device is grounded (with a protective conductor, for example).
  - The measuring head has been temporarily discharged before measurements are taken on a floating measuring device (e.g. touching a bare metal controller housing).
Safety information

Danger

- The device must not be commissioned until you have ensured that the machine in which the components described here are to be installed complies with the 98/37/EU Directive.
- SINAMICS devices and AC motors must only be commissioned by suitably qualified personnel.
- Personnel must take into account the information provided in the technical customer documentation for the product, and be familiar with and observe the specified danger and warning notices.
- Hazardous voltages are present in electrical equipment and motors during operation.
- Dangerous axial movements can occur in the system during operation.
- All work on the electrical system must be carried out when the system has been disconnected from the power supply.
- SINAMICS devices with AC motors must only be connected to the power supply via an AC–DC residual–current–operated device with selective switching once verification has been provided that the SINAMICS device is compatible with the residual–current–operated device in accordance with EN 50178, Chapter 5.2.11.2.

Warning

- The successful and safe operation of these devices and motors depends on correct transport, proper storage and installation, as well as careful operation and maintenance.
- The specifications in the catalogs and offers also apply to special variants of the devices and motors.
- In addition to the danger and warning information provided in the technical customer documentation, the applicable national, local, and system–specific regulations and requirements must be taken into account.
- Only protective extra–low voltages (PELVs) that comply with EN60204–1 must be connected to all connections and terminals between 0 and 48 V.
Caution

- The surface temperature of the motors can reach over +80°C.
- For this reason, temperature–sensitive parts (lines or electronic components, for example) must not be placed on or attached to the motor.
- When attaching the connecting cables, you must ensure that:
  - They are not damaged
  - They are not under tension
  - They cannot come into contact with any rotating parts.

Caution

- As part of routine tests, SINAMICS devices with AC motors undergo a voltage test in accordance with EN 50178. Before the voltage test is performed on the electrical equipment of industrial machines to EN 60204–1, Section 19.4, all connectors of SINAMICS equipment must be disconnected/unplugged to prevent the equipment from being damaged.
- Motors must be connected in accordance with the circuit diagram provided. They must not be connected directly to the three–phase supply because this will damage them.

Note

- When operated in dry operating areas, SINAMICS equipment with three–phase motors conforms to low–voltage Directive 73/23/EEC.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>v</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>xv</td>
</tr>
<tr>
<td><strong>1 Drive Concept</strong></td>
<td></td>
</tr>
<tr>
<td>1.1 Components</td>
<td>1-18</td>
</tr>
<tr>
<td>1.2 Control Unit</td>
<td>1-19</td>
</tr>
<tr>
<td><strong>2 Prerequisites</strong></td>
<td>2-21</td>
</tr>
<tr>
<td>2.1 Hardware and software components</td>
<td>2-21</td>
</tr>
<tr>
<td>2.2 Wiring the components</td>
<td>2-22</td>
</tr>
<tr>
<td>2.2.1 Assembling the drive unit</td>
<td>2-23</td>
</tr>
<tr>
<td>2.3 STARTER Commissioning Tool</td>
<td>2-24</td>
</tr>
<tr>
<td>2.3.1 The STARTER user interface</td>
<td>2-24</td>
</tr>
<tr>
<td>2.3.2 Principle of the STARTER commissioning tool for SINAMICS S120</td>
<td>2-26</td>
</tr>
<tr>
<td>2.4 Commissioning</td>
<td>2-28</td>
</tr>
<tr>
<td>2.4.1 Creating the drive project OFFLINE</td>
<td>2-28</td>
</tr>
<tr>
<td>2.4.2 Using the STARTER control panel (motor rotates)</td>
<td>2-29</td>
</tr>
<tr>
<td>2.4.3 Creating the drive project ONLINE</td>
<td>2-29</td>
</tr>
<tr>
<td><strong>3 Creating the Drive Project OFFLINE</strong></td>
<td>3-31</td>
</tr>
<tr>
<td>3.1 Creating the project</td>
<td>3-32</td>
</tr>
<tr>
<td>3.2 Configuring the drive unit</td>
<td>3-43</td>
</tr>
<tr>
<td><strong>4 Using the STARTER Control Panel (Motor Rotates)</strong></td>
<td>4-55</td>
</tr>
<tr>
<td>4.1 Prerequisites</td>
<td>4-55</td>
</tr>
<tr>
<td>4.2 Loading the project to the drive unit</td>
<td>4-56</td>
</tr>
<tr>
<td>4.3 Using the control panel</td>
<td>4-59</td>
</tr>
<tr>
<td><strong>5 Creating the Drive Project ONLINE</strong></td>
<td>5-67</td>
</tr>
<tr>
<td>5.1 Prerequisites</td>
<td>5-67</td>
</tr>
<tr>
<td>5.2 Creating the project</td>
<td>5-68</td>
</tr>
<tr>
<td>5.3 Entering the component topology and configuring the drive unit</td>
<td>5-72</td>
</tr>
<tr>
<td>automatically</td>
<td></td>
</tr>
<tr>
<td>5.4 Configuring the drive motors and checking the topology</td>
<td>5-76</td>
</tr>
<tr>
<td><strong>Glossary</strong></td>
<td>G-81</td>
</tr>
<tr>
<td><strong>Index</strong></td>
<td>Index-89</td>
</tr>
</tbody>
</table>
Drive Concept

This "Getting Started" manual uses simple examples to describe how a standard drive application is configured.

The standard application comprises a minimum configuration of a SINAMICS S120. Commissioning is carried out using the STARTER commissioning tool.

This chapter provides an introduction to the SINAMICS drive concept.

---

Note

A detailed description of the drive system is available in the Commissioning Manual /IH1/ and Equipment Manuals /GH1/ and /GH2/ (see References in the appendix).
1.1 Components

SINAMICS is a modular system that enables you to build your drive.
The key components of the SINAMICS modular system are:

- Control Unit
- Active Line Module (infeed)
- Motor Module (power section)
- Sensor Module
- Terminal Module

Fig. 1-1 shows the key drive components (the required 24 V DC power supply, line filters, line reactors, line contactors, and power cables are not shown):

![Diagram of SINAMICS modular system components](image)

**Interface (component connection)**

The central Control Unit communicates with the intelligent, peripheral drive components (Motor Modules, Terminal Modules, and Sensor Modules) via a standard digital interface (DRIVE–CLiQ).
The physical arrangement of the connections between the Control Unit and peripheral drive components is known as the DRIVE–CLiQ topology.
1.2 Control Unit

The Control Unit is responsible for all closed-loop/open-loop and communication functions with the drive system components.

The following functions are available:

- Closed-loop control of the Active Line Module (infeed)
- Closed-loop control for the drive (comprising the motor, Motor Module, speed sensor/position encoder, and Sensor Module)
- Communication with a higher-level controller
- Communication with the commissioning system (STARTER)
- Evaluation of the inputs/outputs on the Control Unit
- Evaluation of the optional Terminal Modules
- Evaluation of an Option Board plugged into the Control Unit
Prerequisites

This chapter describes the prerequisites for step-by-step configuration and commissioning.

The configuration and commissioning steps are described in detail in Chapters 3 and 5.

2.1 Hardware and software components

In our example, a drive unit is to be assembled for a motor.

The following components are required for the drive unit:

- Active Line Module
- Control Unit CU320
- Motor Module
- Sensor Module SMC20
- Synchronous motor (e.g. 1FK6) or induction motor (e.g. 1PH7) with sensor
- DRIVE–CLiQ cables

You will also need line filters, line reactors for the Active Line Module, motor, power, and encoder cables, as well as a SITOP modular 24 V DC power supply, for example.

The following prerequisites must be fulfilled before you start commissioning:

- The CompactFlash Card with firmware must be inserted.
- The components are wired by means of DRIVE–CLiQ
- The PROFIBUS interface Control Unit is connected to a PC/PG via a PROFIBUS interface
- The STARTER commissioning tool must be installed on your PC/PG.

Note

For instructions on wiring the components, connecting the PROFIBUS interface to a PC/PG, and installing the STARTER commissioning tool, see the Equipment Manuals /GH1/ and /GH2/ and the Commissioning Manual /IH1/.
2.2 Wiring the components

Fig. 2-1 shows how the components can be arranged and interconnected for the sample project. The DRIVE–CLIQ wiring is highlighted in bold.

Fig. 2-1 Component wiring (example)
2.2.1 Assembling the drive unit

The components must be assembled in accordance with the specifications in the Equipment Manuals /GH1/ and /GH2/ and the DRIVE–CLiQ wiring guidelines in the Commissioning Manual /IH1/.

Note
The installation and wiring procedures are described in the Chapter "Cabinet configuration and EMC booksize" in the Equipment Manual.

DRIVE–CLiQ

To assemble the drive unit components, wire the DRIVE–CLiQ cables as follows (see also Fig. 2-1):

1. Start by connecting DRIVE–CLiQ socket X100 on the CU320 to DRIVE–CLiQ socket X200 on the Active Line Module.
2. Connect X101 on the Control Unit to X200 on the Motor Module.

PROFIBUS address

4. A PROFIBUS switch that you can use to set the PROFIBUS address for the drive unit is located behind the lower, petrol–green removable cover on the CU320. Set the PROFIBUS address (e.g. 5 (S1 + S3 = ON)).

Fig. 2-2 shows the significance of the PROFIBUS switch.

<table>
<thead>
<tr>
<th>Significance</th>
<th>2⁰</th>
<th>2¹</th>
<th>2²</th>
<th>2³</th>
<th>2⁴</th>
<th>2⁵</th>
<th>2⁶</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>2</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>4</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>8</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>16</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>32</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
<tr>
<td>64</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
<td>ON</td>
</tr>
</tbody>
</table>

Fig. 2-2 Example: setting the PROFIBUS via the PROFIBUS switch on the Control Unit

CompactFlash card

5. Insert the CompactFlash card with SINAMICS S120 firmware into the Control Unit CU320.

24 V power supply

6. Switch on the 24 V power supply.

PC/PG PROFIBUS interface

7. Use a PROFIBUS cable to connect the PC/PG to the CU320 via the PROFIBUS interface.
2.3 STARTER Commissioning Tool

To start the STARTER application, click the STARTER icon or choose the following menu path in the Windows start menu: Start > SIMATIC > STEP 7 > STARTER.

Note
The screenshots used in this manual are from STARTER version V3.2. Screens in other versions may differ slightly from those used here.

2.3.1 The STARTER user interface

You can use STARTER (see Fig. 2-3 on the following page) to create the sample project. The different areas of the user interface are used for different configuration tasks:

- Project navigator: this area displays the elements and objects that can be added to your project.
- Working area: You create the project in this area:
  - When you are configuring the drive, this area contains the Wizards that help you configure the drive objects.
  - You can configure the parameters for the speed setpoint filter, for example.
  - When you call up the expert list, the system displays a list of all the parameters that you can view or change.
- Detail view: this area contains detailed information on faults and alarms, for example.
Prerequisites

**Fig. 2-3** The different areas of the STARTER user interface

- **Project navigator**: displays the elements and objects for the STARTER project.
- **Working area**: Displays the Wizard for configuring the drive objects.
- **Displays the parameters for the speed setpoint filter, for example.**
- **Detail view**: Displays specific information (faults, for example).
2.3.2 Principle of the STARTER commissioning tool for SINAMICS S120

When you create a drive unit for a SINAMICS S120 system, the following principles apply:

The tool is used to configure objects (e.g. infeed). The object name is user defined.
In STARTER, a drive unit always comprises a Control Unit and the associated drives.
With a controlled infeed, the Active Line Module is configured in STARTER. An uncontrolled infeed is not configured in STARTER.
The appropriate drive consists, for example, of a Motor Module (power section) and of a motor with encoder.

Fig. 2-4 shows the STARTER project navigator. You can see that a project (Project_Philosophy) and a drive unit (Drive_Unit_One_Motor) have been configured for a drive.

![Drive unit with one motor](image)
If you then want to create a drive unit for two motors, the drive unit will still comprise one Control Unit and one Active Line Module (infeed), but this time will include two drives.

Fig. 2-5 shows the STARTER project navigator. A second drive unit with the name **Drive_Unit_Two_Motors**, which is designed for two drives, has been configured in the same project (**Project_Philosophy**).
2.4 Commissioning

Once you have carried out the steps described in Sections 2.1 to 2.3 (DRIVE–CLiQ wiring, connecting the Control Unit to a PC/PG via PROFIBUS, STARTER on PC/PG), you can start commissioning using the example provided.

STARTER offers two alternative methods for creating a drive project:
- OFFLINE: you use a Wizard to configure and parameterize the drive unit.
- ONLINE: you use a Wizard to load the existing drive unit configuration and parameterization to STARTER.

If you have created or loaded a project in STARTER, you can operate the drive via the STARTER control panel.

Sections 2.4.1 to 2.4.3 contain tables listing the main commissioning steps for this example. For detailed descriptions, see Chapters 3 to 5.

2.4.1 Creating the drive project OFFLINE

To create the drive project OFFLINE, carry out the following steps:

<table>
<thead>
<tr>
<th>Table 2-1 OFFLINE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
</tbody>
</table>
2.4.2 Using the STARTER control panel (motor rotates)

You have to carry out the following steps to use the STARTER control panel and activate the motor:

Table 2-2 Motor rotates

<table>
<thead>
<tr>
<th>Step</th>
<th>Version</th>
<th>Chapter/section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the project.</td>
<td>4.2</td>
</tr>
<tr>
<td>2</td>
<td>Establish a connection to the target system. Switch to ONLINE mode.</td>
<td>4.2</td>
</tr>
<tr>
<td>3</td>
<td>Load the project to the drive unit. When doing so, watch the LEDs on the Control Unit. These indicate when the project has been fully loaded.</td>
<td>4.2</td>
</tr>
<tr>
<td>4</td>
<td>Save the parameters in the drive unit with RAM to ROM.</td>
<td>4.2</td>
</tr>
<tr>
<td>5</td>
<td>Use the control panel in the STARTER. <strong>The motor starts to rotate.</strong></td>
<td>4.3</td>
</tr>
</tbody>
</table>

2.4.3 Creating the drive project ONLINE

To create the drive project ONLINE, carry out the following steps:

Table 2-3 ONLINE

<table>
<thead>
<tr>
<th>Step</th>
<th>Version</th>
<th>Chapter/section</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start the STARTER commissioning tool.</td>
<td>5.2</td>
</tr>
<tr>
<td>2</td>
<td>Create a new project.</td>
<td>5.2</td>
</tr>
<tr>
<td>3</td>
<td>Set up the PROFIBUS interface.</td>
<td>5.2</td>
</tr>
<tr>
<td>4</td>
<td>Carry out an ONLINE search for the stations (drive units) that you can access. The drive unit is inserted in the project.</td>
<td>5.2</td>
</tr>
<tr>
<td>5</td>
<td>Configure and enter the drive unit topology and configuration automatically.</td>
<td>5.3</td>
</tr>
<tr>
<td>6</td>
<td>Configure the motor and check the topology that has been entered.</td>
<td>5.4</td>
</tr>
<tr>
<td>7</td>
<td>Save the project.</td>
<td>5.4</td>
</tr>
<tr>
<td>8</td>
<td>Continue with &quot;Using the STARTER control panel (motor rotates)&quot;.</td>
<td>4.3</td>
</tr>
</tbody>
</table>
Creating the Drive Project OFFLINE

This chapter shows you how to create the sample project in STARTER by carrying out the following activities OFFLINE:

- Creating a new project
- Defining an interface
- Inserting a drive unit
- Configuring the drive unit and its components
3.1 Creating the project

Start by opening a new project for your example:

1. To start the STARTER commissioning tool, click the STARTER icon or choose the following menu path in the Windows start menu: Start > Simatic > STEP 7 > STARTER.

When the software is started for the first time, the main screen (see Fig. 3-1) appears with the following windows:

- “STARTER Project Wizard”
- “STARTER Getting Started Commissioning Drive”

![The project Wizard can be called using the menu Project > New with Wizard.](image)

Note

If you deactivate the “Display Wizard during start” field, the project Wizard is not displayed when you next start STARTER.

The project Wizard can be called using the menu Project > New with Wizard.

![If you deactivate this field, the project Wizard is not displayed the next time you start the STARTER.](image)
Note
To deactivate the online help for “Getting started”, follow the instructions provided in Help.
You can call up the online help at any time by choosing “Help -> Getting started”. STARTER features a detailed online help function.

2. Close the online help and follow the instructions provided by the Project Wizard STARTER.

3. Choose **Arrange drive units offline** (see Fig. 3-2).

![Project Wizard Starter](image)

Fig. 3-2  Project Wizard Starter
The Wizard guides you through the procedure for creating a new project.

4. Enter the **project name** and, if required, a **comment** (see Fig. 3-3).

![Fig. 3-3 Creating a new project](image)

5. Click **Continue >** to set up a PROFIBUS interface in the PC/PG.

![Fig. 3-4 Setting up the interface](image)

6. In this example, you need a PROFIBUS interface in the PC/PG. Choose **Change and test...**
The system has determined the available interfaces on your PC (e.g. **CP5511 (PROFIBUS)**). Choose an interface from the Interface Parameter Assignment Used selection field and then click Properties.

8. Enter the following properties in the Properties – CP5511 (PROFIBUS) dialog box (see Fig. 3-6):
   - Click the field PG/PC is the only master on the bus.
9. Click **OK**.

10. Click **Diagnostics**.

You can use the diagnostic functions on the **PROFIBUS/MPI Network Diagnostics** tab (see Fig. 3-8) to check whether the communication module for the PROFIBUS line is ready.
If the module is ready for operation, the module reads and displays the bus parameters and version data.

In the second part of the tab (bus nodes), you can generate and display a list of all the bus nodes in the PROFIBUS line.

![SIMATIC NET diagnostics – CP5511 (PROFIBUS) before the test](image)

11. To check the operating status, click on **Test**.
When the module is ready for operation, the text "OK" appears in the field to the right of the pushbutton (see Fig. 3-9).

In this case, the station address is displayed along with the additional current bus parameters and version data.

![Fig. 3-9 SIMATIC NET diagnostics – CP5511 (PROFIBUS) after the test](image)

12. To display the stations, click **Read**.

   When the module is ready for operation, the system generates a list of all the active stations on the bus.

   The symbols for indicating the operating mode of the station have the following meanings:
   - An empty checkbox with a gray background (same background color as the tab): No partner device found
   - Empty checkbox with a light background: Passive station (e.g. DP slave)
   - Checkmark on a light background: Active station (e.g. DP master)
   - Checkmark on a gray background: Active station ready to be integrated into the network

**Note**

This generates considerable load on the bus and may take a few seconds.

13. To complete the process of setting and diagnosing the PC/PG interface, choose **OK, OK** and **Continue >**.
14. Add the following (see Fig. 3-10):
   - A new drive unit with the name **SINAMICS_CU320**
   - A device: **SINAMICS**
   - A type: **S120 (6SL3...)**
   - Version **V2.4** and
   - Bus address (e.g. **5**)

**Note**

The bus address must be the same as the PROFIBUS address set for the Control Unit (see Fig. 2-2).

Section 3.2 shows you how to configure the drive unit and its components.

Insert the drive unit by making the appropriate selection in the selection fields and then clicking on the button **Insert**.

![Project Wizard Starter](image)

**Fig. 3-10**     Inserting the drive unit

**Note**

To insert other drives in the project, choose **Insert**.
The first time you choose **Insert**, the system displays a tutorial featuring an introduction to the SINAMICS S120 drive unit (see Fig. 3-11).

![Fig. 3-11 Introduction](image)

15. Work your way through the introduction by choosing >, or exit by choosing X.

---

**Note**

To call up this tutorial, choose **Sinamics tutorial**.
Once you have inserted the drive unit, the **Preview** window shows you how the completed project will appear in the STARTER project navigator (see Fig. 3-12).

Fig. 3-12  
Preview: “Project_2”

16. Click **Continue >**.

Fig. 3-13  
Summary

17. To complete the process of creating a new project for a drive unit, choose **Complete**.
As you can see in Fig. 3-14, the project Wizard has created **Project_2**, drive unit **SINAMICS_CU320**, and a **Control_Unit** in the project navigator.

**Fig. 3-14** STARTER project navigator “Project_2”

Section 3.2 shows you how to configure the components for the drive unit used in this example.
3.2 Configuring the drive unit

The following components are required to assemble the drive unit used in this example:

- Active Line Module
- Motor Module
- Synchronous motor (e.g. 1FK6) with sensor for servo control variant
- Induction motor (e.g. 1PH7) with sensor for vector control variant

To assemble the drive unit components, proceed as follows:

1. In the project navigator, open the **SINAMICS_CU320** directory and double-click the element **Configure drive unit** (see Fig. 3-14).

   As you can see in Fig. 3-15, the STARTER opens a Wizard for configuring the drive unit components.

   ![Configuration - SINAMICS_CU320 - Option module](image)

   Fig. 3-15 Configuration – SINAMICS CU320 option board

2. An option board is not used in this example.

   Confirm the default setting **No option board** by choosing **Continue >** to carry out the next configuration step.
Creating the Drive Project OFFLINE

3. In this example, you are using a controlled SINAMICS infeed with DRIVE-CLIQ connection, an Active Line Module. Confirm the default setting Yes by choosing Continue >.

**Note**

If you are using an uncontrolled SINAMICS infeed, click No and then Continue >.

4. Click Continue >.
5. First choose the appropriate Active Line Module from the Selection field according to type (Order No.) (see type plate), assign a name (Supply_1), and click the Line filter available field.

6. Click Continue > to select additional data for the Active Line Module (infeed) (see Fig. 3-19).

7. Adapt the supply voltage and rated line frequency for the device accordingly. Click Continue >.
8. For the infeed in this example, you want a free telegram configuration with BICO interconnection. Confirm the default setting Free telegram configuration with BICO by choosing Continue >.

9. You now want to create a drive with a Motor Module (power section), motor, and encoder for this example. Confirm the default setting Yes by choosing Continue >.
Choose Servo or Vector.

Fig. 3-22 Drive properties

10. The drive properties dialog box (see Fig. 3-22) contains general information about the drive.

11. In the selection field, choose “Operating type”.
   - Servo: when you are configuring a synchronous motor with servo control
   - Vector: when you are configuring an induction motor with vector control

12. Assign a name for the first drive, **Drive_1**, and enter some general comments. Click **Continue >**.

13. In the “Control structure” dialog box, select the “control type” (the default setting is standard and can be left as it is) and click on **Continue >**.
14. Choose the appropriate Motor Module from the Motor Module selection field according to type (Order No.) (see type plate) and assign a name (Power unit).

15. Click Continue >.

The following dialog box (see Fig. 3-24) is displayed when you configure an induction motor with vector control.

Configure an induction motor with servo control and then continue with step 18.
16. Choose the "Standard" and the "Power unit application" as shown in Fig. 3-24 (the default setting can be left as it is).

17. Click Continue > to select the motor (see Fig. 3-25).

18. Select the motor type.

19. Select the motor according to type (Order No.).
– 1FK6 synchronous motor or 
– 1PH7 induction motor

19. Choose the appropriate motor from the Motor selection selection field according to type (Order No.) (see type plate) and assign a name (Drive_1_Motor).

20. Click Continue > to select the motor holding brake (see Fig. 3-26).

21. Select "Without holding brake".

21. Select Without holding brake and click on Continue > to select the encoder fitted to the motor (see Fig. 3-27).
22. Select the encoder from the **Motor encoder selection** selection field according to type (Order No.) (see the type plate on the motor) and then press **OK**.

23. Click on **Continue >** to select the process data exchange in the next step (see Fig. 3-28).
24. For the drives in this example, you want a free telegram configuration with BICO interconnection. Confirm the default setting **Free telegram configuration with BICO** by choosing **Continue >**.

The following dialog box (see Fig. 3-29) is displayed when you configure an induction motor with vector control.

Configure an induction motor with servo control and then continue with step 26.

25. Click **Continue >** (the default setting for the most important parameters is standard and can be left as it is).
Fig. 3-30  Summary

26. Check the summary and confirm it by choosing Finish.

As you can see in Fig. 3-31, the configuration Wizard has created the objects (including Drive_1) for drive unit SINAMICS_CU320 in the project navigator.

Fig. 3-31  Project navigator with SINAMICS_CU320

27. Save project Project_2 by choosing Project > Save.

Once you have configured the drive unit with STARTER in OFFLINE mode, continue with the steps described in Chapter 4 “Starting the Drive Project (Motor Rotates)”, where you will set the drive interface parameters and start the motor.
Using the STARTER Control Panel (Motor Rotates)

This chapter shows you how to start the motor by means of the operator panel function in the STARTER. The steps for this include:

- Loading the project to the drive unit
- Using the control panel

4.1 Prerequisites

The following prerequisites for using the STARTER control panel must be fulfilled:

- The components are assembled (as described in Chapter 2).
- The device unit has been switched on in accordance with the instructions.
- The PROFIBUS Control Unit interface is connected to a PC/PG with PROFIBUS interface.
- A project has been created using STARTER.
4.2 Loading the project to the drive unit

To load the project to the drive unit, proceed as follows:

1. If you have not yet opened "Project_2" (created in Chapter 3) or "Project_1" (created in Chapter 5) in STARTER, open the project by choosing Project > Open.

2. To use the "control panel" function, you have to switch to ONLINE mode. To switch to ONLINE mode, click the function key Connect to target system (as shown in Fig. 4-1).

3. An ONLINE connection is established and an ONLINE/OFFLINE comparison is carried out. If any discrepancies are identified, they are displayed (see the following screenshot).
4. You changed the data OFFLINE and now have to load it to the target system. Carry out the following:
   – Click **Load to target system** in the “ONLINE/OFFLINE comparison” dialog box.
   – When the system asks “Are you sure?”, click **Yes**. The system now starts loading the data.
   – When the system informs you that the data was successfully loaded to the target system, click **OK**.
   – Click **OK** for “Load from RAM to ROM”.

5. Discrepancies were identified again during the ONLINE/OFFLINE comparison. Click **Load to PG** (see screenshot below).

6. Load the new data from the drive unit to the PG. Carry out the following:
   – When the system asks “Are you sure?”, click **Yes**. The system now starts loading the data.
– When the system informs you that the data was successfully loaded to the PG, click **OK**.

7. No further discrepancies are displayed in the ONLINE/OFFLINE comparison dialog box. Click **Close** (see screenshot below).

![ONLINE/OFFLINE comparison, close](image)

**Note**

When loading the project, note the LEDs on the Control Unit. The Control Unit is ready for operation when the LED **RDY** is continuously lit (green).

This completes the procedure for configuring the drive unit hardware. The following section shows you how to use the control panel in STARTER.
4.3 Using the control panel

Once you have established a connection with the target system and loaded the project to the target system, a green plug icon appears in front of the drive unit and other configured components in the project navigator. This indicates that the project data in STARTER and the target system is consistent (see Fig. 4-5).

The drive unit is ready to run.

To use the STARTER control panel and start the motor, proceed as follows:

1. Double-click **Control panel** in the project navigator under **Drive_1 > Commissioning** (see Fig. 4-5).

   The control panel is displayed in STARTER (see Fig. 4-6). You can use the control panel to control the drive directly from the PC/PG.
2. Click **Assume control priority** to connect the control panel to the drive interface.

   Note the message that is then displayed in the **Control priority** dialog screen. This message is very important (see also Fig. 4-7).

---

**Danger**

Use control priority with care!

The function should be used for commissioning, diagnostics, and maintenance purposes only.

Make sure that the drive is in the “OFF” status and that no ON/OFF1 command has been issued either by the control word for sequence control or another signal source (e.g. BICO interconnection).

Once control priority has been transferred to the PC, the BICO interconnections on bit 1 to bit 6 of the control word are no longer active.
To continue with commissioning, choose OK.

You can enter an application monitoring time, which is the time that elapses between two setpoints before the sign–of–life monitoring function on the drive responds (fault 1910).

You can use the default monitoring time (e.g. 3000 ms).

3. Since our example concerns commissioning, confirm this dialog box for assuming control priority by choosing OK.

4. To display, amongst other things, the status lamps for the control word bits, click Display/hide diagnostics view.

Table 4-1 lists the most important digital input signals of the control word for sequence control. You need these to set the motor in motion and issue them via the control panel for the Control Unit (CU320).
Table 4-1 Control word sequence control

<table>
<thead>
<tr>
<th>Signal (control panel)</th>
<th>PROFIdrive Bit No. in STW sequence control</th>
<th>Meaning</th>
</tr>
</thead>
</table>
| ON/OFF1                | Bit 0                                     | 0 = OFF (OFF1), stop via ramp–function generator, followed by pulse block  
1 = ON, operating condition |
| ON/OFF2                | Bit 1                                     | 0 = Coast down (OFF2), pulse block, motor coasts to standstill  
1 = Do not coast down, operating condition |
| ON/OFF3                | Bit 2                                     | 0 = Emergency stop (OFF3)  
1 = No emergency stop, operating condition |
| Pulse enable           | Bit 3                                     | 0 = Disable operation, pulse block  
1 = Enable operation, enable pulses |
| Ramp–function generator enable | Bit 4                                    | 0 = Set ramp–function generator to 0  
1 = Enable ramp–function generator |
| Start/stop ramp–function generator | Bit 5                                    | 0 = Freeze ramp–function generator, retain current output value  
1 = Restart ramp–function generator, follows the input value |
| Enable setpoint        | Bit 6                                     | 1 = Enable setpoint  
0 = Block setpoint and set to 0 |

Fig. 4-9 Enables

5. As shown in Fig. 4-9, click the Enables field to set the commands for enabling the control words in the drive system.

Fig. 4-10 Infeed control priority

6. Click Infeed control priority. The infeed (Active Line Module) is powered–up.
7. Before starting the motor by choosing **Drive on** (see Fig. 4-11), you have to make the following settings:
- Enter a speed setpoint (e.g. 50 revolutions per minute).
- Use the slider to set the setpoint in %. Position your cursor on the slider, hold down the left mouse button, and set the speed to 0%.

**Danger**
During commissioning, note the machine traversing range and take appropriate external measures (e.g. monitoring the limit switch).

8. Click **Drive on**. The ON/OFF1 "enable" command is set and displayed on the control panel (see Fig. 4-12).

9. Increase the speed slowly as a percentage from 0 to 100%.

The motor starts to rotate!

10. When you click **Drive off**, the motor stops. You can also trigger a **fast stop** by pressing the space bar.
The following steps show you how to return control priority to terminate the connection to the drive:

- Supply
- Control Unit

11. Click **Infeed control priority** (see Fig. 4-13).

12. Click **Return...** to terminate the connection to the drive unit (see Fig. 4-14).

13. Confirm the query **Return control priority?** with **Yes** (see Fig. 4-15).
The system then returns to the project in STARTER (see Fig. 4-16).

Fig. 4-16  Commissioning complete

Congratulations!

You have successfully completed commissioning a drive using the SINAMICS S120 drive system.
Creating the Drive Project ONLINE

This chapter shows you how to create the sample project ONLINE by carrying out the following steps:

- Create a project.
- Enter and configure the component topology and configuration of the drive unit automatically.
- Configure the drive motors and check the topology.

5.1 Prerequisites

The following prerequisites must be fulfilled before you create a drive project ONLINE with the STARTER commissioning tool:

- The components are assembled (as described in Chapter 2).
- The device unit has been switched on in accordance with the instructions.
- The PROFIBUS Control Unit interface is connected to a PC/PG with PROFIBUS interface.

The SINAMICS firmware is able to recognize the actual topology automatically and store it in the appropriate parameters.
5.2 Creating the project

To ensure that the drive unit configuration is identified automatically, open a new project in STARTER:

1. To start the STARTER commissioning tool, click the STARTER icon or choose the following menu path in the Windows start menu: Start > SIMATIC > STEP 7 > STARTER.

The Project Wizard Starter is displayed.

Fig. 5-1 Project Wizard Starter

2. Choose Find drive units online... (see Fig. 5-1).
The Wizard guides you through the procedure for creating a new project.

3. Enter the **project name** (e.g. "Project_1") and, if required, the **author** and a **comment** (see Fig 5-2).
4. Click **Continue >** to set up the PC/PG interface.

5. In this example, you require a PROFIBUS interface on the PC/PG (e.g. **PC adapter (PROFIBUS)**). Choose **Change and test** and confirm your selection with **Continue >**.
The project Wizard searches for the drive unit ONLINE and inserts it in the project. Once the drive unit has been found, the project Wizard displays it in the preview screen (see Fig. 5-4) along with its PROFIBUS address (Drive_Unit_Adr10).

**Note**

The system searches for drive units or, more precisely, Control Units; in other words, if more than one Control Unit exists in the system, more than one drive unit is found.

The peripheral components of a drive unit (Control Unit, Active Line Module, and so on) are not displayed until you load the drive unit configuration to the PG/PC.

6. Click **Continue >**.
The project Wizard displays a summary of the project (see Fig. 5-5).

![Project Wizard Starter](image)

**Fig. 5-5** Summary

7. Click **Complete**. The new project and drive unit are displayed in STARTER (see Fig. 5-6).
5.3 Entering the component topology and configuring the drive unit automatically

Once you have created the project and entered the drive unit with its PROFIBUS address ONLINE, you have to enter the associated component topology and drive unit configuration ONLINE.

1. Select the drive unit Drive_Unit_Adr10.
2. Choose Connect to target system.

Fig. 5-6  Project_1

3. Select the drive unit Drive_Unit_Adr10 in the project navigator.
4. Choose the Restore factory settings function key (see screenshot below).

Fig. 5-7  Restore factory settings

5. Confirm the following queries and messages by choosing OK:
   - “Restore factory settings?” dialog box
6. In the project navigator, double-click **Automatic configuration** under the drive unit.

7. Click **Start automatic configuration**.

STARTER automatically searches for all drive unit components that are connected properly and then uploads them. In this case, it has recognized a drive.
8. In the “Drive object type” dialog box, choose **Servo** and then click **Complete**. The system now loads the data from RAM to ROM and to the PG.

9. The system outputs another message listing all the drives for which you have to configure the motors in OFFLINE mode. Click **OK** to confirm the message.

**Note**

The drives are equipped with standard motors.

If a drive is equipped with a motor with a DRIVE–CLiQ interface, the motor does not need to be configured in OFFLINE mode.
10. Once the automatic commissioning is complete, click **Close**.

In the project navigator, all the drive unit components that have been found are displayed with, for example, the **Control Unit**, **infeed**, and **drive** (see Fig. 5-13).

11. Choose **Disconnect from target system**.

The drive unit, components, and drives are installed in the STARTER project. You now just have to configure the drive motors and check the topology.

To do so, proceed as described in Section 5.4.
5.4 Configuring the drive motors and checking the topology

Now that you have entered the component topology and configuration for the drive unit and integrated these in the STARTER project automatically by carrying out the steps described in Section 5.3, carry out the following steps to configure the drive motor and check the topology.

1. In the project navigator, choose the Drives folder and double–click **Drive navigator** under the drive.

   The **Drive navigator** dialog box provides an overview in which you can configure the main drive functions.
2. Click **Device configuration** to configure the drive motor.

3. Click **Carry out drive configuration**. The project Wizard for configuring the drive is displayed (see Fig. 5-17).
4. Work through the Wizard by choosing **Continue >** until you reach the point at which you configure the motor (see Fig. 5-18).

**Note**

You only have to change the motor configuration; leave the infeed etc. as they are.

5. Select the motor type.

6. Select the motor according to type (Order No.).
5. Select the motor type e.g.:
   - 1FK6 synchronous motor or
   - 1PH7 induction motor

6. Choose the appropriate motor from the Motor selection field according to type (Order No.) (see type plate) and assign a name (Drive_1_Motor).

7. Click Continue > and work through the Wizard until the summary is displayed (see Fig. 5-19).

---

**Note**

You only have to change the motor configuration; leave the infeed etc. as they are.

---

8. Click Finish.

Before saving the project, check the topology in STARTER.
9. Click **Check topology**.

![Topology tree](image)

Fig. 5-21 Topology tree

10. In this window, check the topology and DRIVE–CLiQ connection and compare this with the actual topology (see Fig. 5-21).

11. Choose **Project > Save** and save the project under the name "Project_1".

To start the motor, continue by carrying out the steps described in Chapter 4.
### Glossary

**Explanation of this glossary (abridged)**

<table>
<thead>
<tr>
<th>German term</th>
<th>English term(^1)</th>
<th>Abbrev.(^1)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Definition of the term in English</td>
<td>(^1) -&gt; if available</td>
</tr>
</tbody>
</table>

---

**Explanation of this glossary**

**Active Line Module**

- **Active Line Module**
  - Controlled, self-commutating feed/feedback unit (with \(\rightarrow\) “IGBT”s in feed/feedback device), which supplies the DC link voltage for the \(\rightarrow\) “Motor module”s.

**Antrieb**

- **Drive**
  - The drive includes the motor (electric or hydraulic), the actuator (converter, valve), the control unit, measuring system, and supply components (line infeed module, pressure reservoir).
  - For electric drives, a distinction is made between a converter system and an inverter system. With a converter (e.g. \(\rightarrow\) “MICROMASTER 4”), the line infeed, the actuator, and the control component form a single device from the point of view of the user. With an inverter system (e.g. \(\rightarrow\) “SINAMICS S”), the supply is ensured by means of an \(\rightarrow\) “Line module”, thereby realizing a DC link to which the \(\rightarrow\) “Inverters” (\(\rightarrow\) “Motor module”s) are connected. The \(\rightarrow\) “Control unit” is implemented as a separate device and connected to the other components by means of \(\rightarrow\) “DRIVE–CLiQ”.

**Antriebsgerät**

- **Drive Unit**
  - The drive unit includes all the components connected via \(\rightarrow\) “DRIVE–CLiQ” that are required for carrying out drive tasks: \(\rightarrow\) “Motor module” \(\rightarrow\) “Control unit” \(\rightarrow\) “Line module”, and the required \(\rightarrow\) “Firmware” and \(\rightarrow\) “Motor”s, but not additional components (such as filters or reactors).
  - Several \(\rightarrow\) “Drive”s can be implemented in a drive unit.
  - See \(\rightarrow\) “Drive system”.

---

\(^1\) Note: Abbreviations are provided if available.
Antriebskomponente
Drive Component

Hardware component connected to a → Control Unit via → DRIVE–CLiQ, for example.
Examples of drive components: → "Motor module"s, → "Line module"s, → "Motor"s, → "Sensor module"s, and → "Terminal module"s.
The overall arrangement of a control unit including the connected drive components is called a → "Drive unit".

Antriebsobjekt
Drive Object

A drive object is an autonomous, individual software function with its own → "Parameter"s. It may also have its own → "Fault"s and → "Alarm"s. The drive objects may exist by default (e. g. On–board I/O) and may be easy to create (e. g. → "Terminal board" 30, TB30). It may also be possible to create more than one (e. g. → "Servo control"). As a rule, each drive object has its own → "STARTER" window for parameterization and diagnostic purposes.

Antriebs–Parameter
Drive Parameter

Parameters of a drive axis that include, for example, the parameters of the corresponding controllers, as well as the motor and encoder data. The parameters of the higher–level technology functions (positioning, ramp–function generator), however, are called → "Application Parameters".
See → "Basic Unit System".

Antriebssystem
Drive system

The drive system includes all the components in a product family (e. g. SINAMICS). A drive system comprises, for example, → "Line module"s, → "Motor module"s, → "Encoder"s, → "Motor"s, → "Terminal module"s, and → "Sensor module"s, as well as additional components (reactors, filters, cables, etc.).
See → "Drive Unit"

Antriebsverband
Drive line–up

A drive line–up comprises a → Control Unit and the and the → Motor Modules and → Line Modules connected via → "DRIVE–CLiQ".

Basic Infeed
Basic Infeed

Overall functionality of an infeed with → "Basic Line Module", including the required additional components (filters, switching devices, and so on).

Basic Line Module
Basic Line Module

Unregulated line infeed unit (diode bridge or thyristor bridge, without feedback) for rectifying the line voltage of the → "DC Link".
Use this term in all languages.
<table>
<thead>
<tr>
<th><strong>CompactFlash Card</strong></th>
<th><strong>CompactFlash Card</strong></th>
<th>none</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory card for non-volatile storage of the drive software and corresponding &quot;Parameters&quot;. The memory card can be plugged into the &quot;Control unit&quot; from outside.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Control Unit</strong></th>
<th><strong>Control Unit</strong></th>
<th>CUxxx</th>
</tr>
</thead>
</table>
| Central control module: the feedforward and feedback control functions for several "SINAMICS" Line Module"s, and/or "Motor Module"s are implemented in this module. There are three types of control unit:  
– SINAMICS control units (e.g. "CU320")  
– SIMOTION control units (e.g. "D425" and "D435")  
– SINUMERIK control units (e.g. NCU710, NCU720, and NCU730) | | |

<table>
<thead>
<tr>
<th><strong>CU320</strong></th>
<th><strong>CU320</strong></th>
<th>none</th>
</tr>
</thead>
<tbody>
<tr>
<td>SINAMICS &quot;Control unit&quot; with 4 DRIVE–CLiQ socket&quot;s and 16 digital inputs/outputs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Double Motor Module</strong></th>
<th><strong>Double–Motor Module</strong></th>
<th>none</th>
</tr>
</thead>
</table>
| Two motors can be connected to and operated with a Double Motor Module. See "Motor module" "Single motor module"  
Former term: "Double–axis module" | | |

<table>
<thead>
<tr>
<th><strong>DRIVE–CLiQ</strong></th>
<th><strong>DRIVE–CLiQ</strong></th>
<th>none</th>
</tr>
</thead>
<tbody>
<tr>
<td>Abbreviation for &quot;drive component link with IQ&quot;. Communication system for connecting the different components of a SINAMICS drive system (e.g. &quot;Control unit&quot;, &quot;Line module&quot;s, &quot;Motor module&quot;s, &quot;Motor&quot;s, and speed/position encoders. The DRIVE–CLiQ hardware is based on the Industrial Ethernet standard and uses twisted-pair lines. The DRIVE–CLiQ line provides the transmit and receive signals, as well as the +24 V power supply.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Einspeisung</strong></th>
<th><strong>Feeding Section</strong></th>
<th>none</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input component of a converter system for generating a DC link voltage to supply one or more &quot;Motor module&quot;s, including all the required components (e.g. &quot;Line module&quot;s, fuses, reactors, line filters, and firmware, as well as proportional computing power (if required) in a &quot;Control unit&quot;.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
externer Geber  

**External encoder**  

Position encoder that is not built in or mounted on the -> Motor, but via a mechanical transmission element or mechanical intermediate element. The external encoder (see -> “Externally-Mounted Encoder”) is used for -> "Direct Position Detection".

Geber  

**Encoder**  

An encoder is a measuring system that captures actual values for the speed and/or angular/position values and makes them available for electronic processing. Depending on the mechanical construction, encoders can be integrated in the -> "Motor" (-> "Motor encoder") or mounted on the external mechanics (-> "External encoder"). Depending on the type of movement, a distinction is made between rotary encoders (also known as "rotary transducers") and translatory encoders (e.g. -> "Linear encoders"). In terms of measured value provision, a distinction is made between -> "Absolute encoder"'s (code sensors) and -> "Incremental encoder"'s.  
See -> "Incremental encoder TTL/HTL"  
-> "Incremental encoder sin/cos 1 Vpp"  
-> "Resolver"

Line Module  

**Line Module**  

A line module is a power component that generates the DC link voltage for one or more -> "Motor module"'s from a 3-phase mains voltage. The following three line module types are used for SINAMICS: -> "Basic Line Module", -> "Smart Line Module", and -> "Active Line Module". The overall function of an infeed, including the required additional components (-> "Line reactor", proportional computing power in a -> "Control unit", switching devices, and so on), is called -> "Basic infeed", -> "Smart infeed", and -> "Active infeed".

Motor  

**Motor**  

For the electric motors that can be driven by -> "SINAMICS", a basic distinction is made between rotary and linear motors with regard to their direction of motion, and between synchronous and induction motors with regard to their electromagnetic operating principle. For SINAMICS, the motors are connected to a -> "Motor Module".  

Motor Module  

**Motor Module**  

A motor module is a power unit (DC–AC inverter) that provides the power supply for the connected motor(s). Power is supplied through the -> "DC link" of the -> "Drive unit". A motor module must be connected to a > "Control unit" via a -> "DRIVE–CLiQ". The open–loop and closed–loop control functions of the motor module are stored in the control unit. -> "Single Motor Module"'s and -> "Double Motor Module"'s are available.
### Motor Encoder

An → "Encoder" (e.g. → "Resolver", → "Incremental encoder TTL/HTL", or → "Incremental encoder sin/cos 1 Vpp"), which is integrated in or attached to the motor.

The encoder detects the motor speed and, in the case of synchronous motors, also the rotor position angle (of the commutation angle for the motor currents). For drives without an additional → "Direct position measuring system", it is also used as a → "Position encoder" for position control.

In addition to the motor encoders, → "External Encoder"s for → "Direct Position Sensing" are available.

### Option Board

PC board inserted in the → "Control unit" (e.g. a → "Terminal board" 30, TB30).

### Option Slot

Slot for an optional module (e.g. in the → "Control Unit").

### Parameter

Variable quantity within the drive system that the user can read and, in some cases, write. For →SINAMICS, all specifications defined in the → PROFIdrive profile are defined by a parameter.

See → "Visualization parameter" → "Adjustable parameter"

### PROFIBUS

Field bus to IEC 61158, Sections 2 to 6.

The abbreviation "DP" is no longer included because PROFIBUS FMS is not standardized and PROFIBUS PA (for Process Automation) is now part of the "general" → "PROFIBUS".

### Sensor Module

Hardware module for evaluating speed/position encoder signals and providing detected actual values as numerical values at a → "DRIVE–CLiQ socket".

Three mechanical sensor module variants are available:

- SMCxx = Cabinet–mounted sensor module = sensor module for snap–on mounting in the control cabinet.
- SME = Sensor module externally mounted = sensor module with high degree of protection for installation outside the cabinet unit
- SMI = Sensor module internal = sensor module integrated in the motor flange outlet
Servoantrieb  
Servo Drive  
none

An electric servo drive comprises a motor, a → "Motor module", a → "Servo control" and, in most cases, a speed and position → "Encoder".

Electric servo drives are normally extremely precise with a high dynamic response. They are designed for cycle times to less than 100 ms, and often have a short–time overload capacity, which enables quick acceleration. Servo drives are available as rotary and linear drives. and are used for machine tools, handling robots, and packaging machines.

Servoregelung  
Servo Control  
none

For → "Motor"s equipped with a → "Motor encoder", this control type allows operation with a high level of → "Accuracy" and → "Dynamic response".

In addition to the speed control, a position control can be implemented.

SITOP power  
SITOP Power  
none

→ "Electronics power supply" component.

Example: 24 V DC

Smart Line Module  
Smart Line Module  
none

Unregulated line infeed/feedback with a diode bridge for the infeed and stall–protected, line–commutated feedback via → "IGBT"s.

The smart line module provides the DC link voltage for the → "Motor Module"s.

STARTER  
STARTER  
none

STARTER is used to commission and parameterize drive units. This tool can also be used to execute the diagnostic functions required during servicing (e.g. PROFIBUS diagnostics, function generator, trace).

See → "SIZER", → "Engineering System".

Steuerwort  
Control Word  
STW

Bit–coded → "Process data" word. → "PROFIdrive" transmits this word at cyclic intervals to control the drive states.

Terminal Board  
Terminal Board  
TBxx

Terminal extension module for plugging into a → "Control Unit".

In → "SINAMICS", for example, terminal board 30 (TB30) is available with analog and digital I/O terminals.
**Terminal Module**

Terminal extension module for snapping onto the installation rail, for installation in the control cabinet.

In -> "SINAMICS", for example, the following terminal modules are available:
- TM3x = terminal modules with digital and analog I/O terminals
- TM4x = terminal modules with encoder emulation

<table>
<thead>
<tr>
<th><strong>Terminal Module</strong></th>
<th><strong>TMxx</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Terminal extension module for snapping onto the installation rail, for installation in the control cabinet.</td>
<td></td>
</tr>
</tbody>
</table>

**Vektorregelung**

Vector control (field-oriented control) is a high-performance control type for induction machines. It is based on an exact model calculation of the motor and two current components that simulate and accurately control the flux and torque by means of software algorithms, thereby enabling predefined speeds and torques to be observed and limited accurately and with a good dynamic response.

Two vector control types exist:
- The frequency control (→ "Sensorless vector control") and the speed–torque control with speed feedback (→ "Encoder").

**Zustandswort**

Bit-coded → "Process data" word. PROFIdrive transmits this word at cyclic intervals to control the drive states.

The abbreviation "ZSW" must be used in all languages!
Index

Numbers
24 V power supply, 2-23

A
Assume control priority, 4-60
Automatic configuration, 5-73

C
Check topology, 5-80
CompactFlash card, 2-21, 2-23
Components, 1-18, 2-21
Configuring the drive unit, 3-43
Connect to target system, 4-56
Control panel, 4-55, 4-59
Control Unit, 1-18, 1-19
Control unit, 1-18
Control word CTW1, 4-62

D
Detail view, 2-24
Device configuration, 5-77
Drive configuration, 5-77
Drive navigator, 5-76
Drive off, 4-63
Drive on, 4-63
Drive, 3-46, 3-47
Drive unit, 2-21

E
ESDS information, xii

F
Find drive units online..., 5-68

I
Infeed, 1-18
Information
Electrostatic sensitivity, xii
Safety, xiii
Inserting the drive unit, 3-39
Interface, 1-18

L
Line Module, 1-18

M
Motor Module, 1-18
Motor rotates, 4-55

O
Operating range, 2-24
Operating type, 3-47

P
Power Section, 1-18
PROFIBUS address, 2-23
PROFIBUS switch, 2-23
Project navigator, 2-24

R
Return control priority, 4-64
Index

S
Sensor Module 1-18
Servo 3-47
Servo control 3-47
Start automatic configuration 5-73
STARTER 2-21
STARTER Commissioning Tool 2-24
Supply 3-45

T
Terminal Module 1-18

U
User interface 2-24

V
Vector 3-47
Vector control 3-47

W
Wiring 2-22
To  
SIEMENS AG  
A&D MC MS  
Postfach 3180  
D–91050 Erlangen  
Tel.: +49 (0) 180 / 5050 – 222 (Hotline)  
Fax: +49 (0) 9131 / 98 – 63315 (Documentation)  
mailto:motioncontrol.docu@siemens.com

<table>
<thead>
<tr>
<th><strong>From</strong></th>
<th><strong>Suggestions</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td></td>
</tr>
<tr>
<td>Company/Dept.</td>
<td></td>
</tr>
<tr>
<td>Street</td>
<td></td>
</tr>
<tr>
<td>Zip code:</td>
<td>City:</td>
</tr>
<tr>
<td>Telephone:</td>
<td>/</td>
</tr>
<tr>
<td>Fax:</td>
<td>/</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Corrections</strong></th>
<th><strong>Getting Started</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>For publication/manual:</td>
<td>Order No.: 6SL3 097–2AG00–0BP3</td>
</tr>
<tr>
<td>SINAMICS S120</td>
<td>Edition: 03/2006</td>
</tr>
</tbody>
</table>

Suggestions and/or corrections

Should you come across any printing errors when reading this publication, please notify us on this sheet. Suggestions for improvement are also welcome.